
COMPUTER APPLICATIONS 
10. HTML - Structural Tags 

 

SECTION-B 
 

Answer to the following questions (2 Marks): 

1 Sandhiya is creating a webpage. She is entering HTML code on her computer. In 
between, she keeps pressing “Refersh” / “Reload” button on her browser. What 

is the purpose? 
Reload / Refresh button is used to get the changes from the source file: 

 After modify and save the source file, minimize your source file. 
 Go to the browser. 
 Click Refresh (Internet Explorer) / Reload Current Page (Firefox) / Reload this 

page (Chrome) icons on the address bar. 
 Press Ctrl + R or F5 will be used to refresh / reload the modifications. 

2. Explain with the help of an example the difference between container and empty 

elements of HTML. 
Container Elements:  

The tags which are required opening and closing is known as container elements or tags. 
For example: <html>, <body>, <title>, <p> etc., 
Empty Elements: 

The tags which are required only opening tag is known as empty elements or tags. For 
example: <br>,<hr>,etc., 
3. What is the wrong in the following coding?  

Wrong Correct 

<html>  
<my web page>  

<title> Welcome to my web page  
</head>  

</title> 

 

<html> 
<head>  <title> my web page </title> 

</head> 
<body> 
Welcome to my web page 

</body></html> 

4. How do you define comments in HTML? 
The tag <!> is used to create comments. In HTML, the text what you type within this tag 
is considered as comments and it is ignored by the browser. Comments never show up 

onscreen. Comments can be placed anywhere in HTML document. 
The general form of comments:  

  <! comments > 

5. How do you include an image as your web page background? 
An image or picture can be applied as background to a webpage. When you insert an 

image as background, the text will be displayed on top of the image. Background images 
can be a texture or bitmap or even a photo. 

The attributes to apply an image as background:  
<body background = “image_name_with_extenstion”> 

 

SECTION-C 

Answer to the following questions (3 Marks): 

1. Explain the attributes available with <body> tag. 
Attributes of <body> tag 
(i) Background Colour: bgcolor = color 

 By default all the browsers display the text on white background. However, the 
background color of the browser can be changed by using bgcolor tag.  

The tag to change background colour:  
 <body bgcolor = color_name/color_code> 
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(ii) Body text Colour: text = color  
The default text colour of body section is “black”, it is often called as automatic color. text 
attribute within body tag is used to change the text colour.  

The tag to change body text colour:  
 <body text = color_name/color_code> 

(iii) Background image: background=image 
  An image or picture can be applied as background to a webpage. When you insert 
an image as background, the text will be displayed on top of the image. Background 

images can be a texture or bitmap or even a photo. 
The tag to apply an image as background:  
  <body background = “image_name_with_extenstion”> 

  If your image file name is long or split as two more words or along with path, 
should be specify within double quotes. 

 For example, If the image file is somewhere in a folder (say Images folder in E: 
drive), you must specify its full path within double quotes as given below.  
Exmaple: 

  <body background = “E:\Images\ flower01.gif"> 
(iv) Setting Margins: margin = value 

 The margin refers the blank area from left or top edge of the browser window. 
Generally there is no default margin setting in any browser. If you want to leave some 
space as margin to left or top; leftmargin or topmargin attributes will be used 

respectively.  
The tag to specify the left and top margin:  
 <body leftmargin = value topmargin = value>  

  The Value is referred as pixels (72 pixels to an inch) 
2. What are the attributes available in <html> tags? 

  The <html> tag has two attributes viz. dir and lang to specify the text direction 
and language setting respectively. 

attribute Value to be set to 
attribute 

Description 

dir ltr (align left-to-right) 

rtl (align right-to-left) 

dir attribute specifies the direction of the text to 

be aligned within the entire document. It is global 
attribute.       ltr is the default value 

rtl is used for Arabian languages. 

lang Predefined language 

code 
English – en 
Tamil – ta 

Telugu – te 

lang attribute specify the language used within 

the document. Predefined language code will be 
used for this purpose. 
Malayalam – ml; Kannada – kn; Hindi – hi; 

French – fr; German – de;  

3. How do you view the source file? 

Viewing Source file  
 Source file is an HTML document, what you actually type in text editor (Notepad or 
gedit). You can view your original source file in the browser. The following steps are to be 

followed to view a source file. 

 Right click on the browser 

 Select View Page Source (Firefox and Chrome) / View Source (Internet  
  Explorer) or Press Ctrl + U (all browser) Source file will be displayed. 

In Internet Explorer, View → Source is also used to open source file. 
Remember that, you cannot edit the source file opened using the methods you learnt 

above. 
4. How do you save a file as HTML file?  
To Save the file as HTML 
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Followed the Steps:  
 Click File → Save (or) Press Ctrl + S 
 Save as dialog box appears  
 In “File Name” text box, type a file name with .htm or .html extension. 
 Select “All Files” from “Save as type” list box. 
 Click “Save” button.  

Book Question 
How do you open a file in a Browser? 

Step 1: Open a Browser (Internet Explorer / Mozilla Firefox or any)  
Step 2: Click File → Open File (or) Press Ctrl + O  
 • If menu bar is not visible in your browser  

Step 3: From the “Open” dialog box, browse the folder in which the HTML document is 

saved. Choose the File name and click “Open” button. 
Now, your web page is displayed in the browser. 
How do you edit a source file? 
 When you edit a source file, no need to close browser in which displaying the 
HTML document. The following steps are to be followed to open a source file. 

 Go to the folder in which your source files are located. 

 According to you default browser, your source file icon is displayed.  

 Right click on the source file that you want to edit 

 From the pop-up menu, select Open With → Notepad 

 Source file will be opened in text editor 

 Make the changes and save the file using File → Save or Ctrl + S.  
 
Define Tags? 

 Tags are known as elements of HTML. 

 You cannot create your own tags to create a new style or feature. 

 All HTML tags should be specified within angle brackets (< >). For example, 

<HTML> is a tag.  

 HTML is not case sensitive that means you can write an HTML tag in lower case or 

in upper case (Small letter or Capital letter).  

 Browser treats both of them in the same manner. For example, you can write 

<HTML> as <html>; both are same. 

 Opening and closing tags are the same name, but closing tag name preceded by a 

slash ( / ). 
Define Attributes? 

 Attributes are special words used inside a tag to specify additional information to 

a tag. Attributes should be placed within the opening tag. Most of the tags support 
specialized attributes and there are also a few global elements that can be used with any 

tag. Global elements are common to all HTML elements; they can be used on all 
elements. 

What are Structural Tags of HTML: 

Opening 

Tag 

Closing 

Tag 
Description 

<html> </html> 

The <html> tag identified the document as an HTML 

document.  
All HTML documents should begins with <html> and end with 
</html>. 

<head> </head> 
The <head> tag contains information about the document, 
including its title, scripts used, style definition and document 

descriptions. 

<title> </title> 

The <title> tag contains the title of the document.  

The title specified between opening and closing tags appears in 
the title bar / page tab of the browser. 
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<title> tag should be placed within <head> tag. 

<body> </body> 
The <body> tag encloses all the tags, attributes and 
information to be displayed in the web page.  

<body> tag should be entered below the </head> tag.  

 

How do you Creating a Webpage? 
Creating a Webpage 
Step 1: Open a text editor  

 Windows7 : Start → All Programs →Accessories → Notepad  

 Linux : Applications → Accessories → Text Editor 

Step 2: In the appearing Note pad / Text Editor, type the HTML document. 
Step 3: Save the file as HTML 

 Click File → Save (or) Press Ctrl + S 

 Save as dialog box appears  

 In “File Name” text box, type a file name with .htm or .html extension. 

 Select “All Files” from “Save as type” list box. 

 Click “Save” button.  

How will you change color in HTML Documents? 
 HTML code, color name has been used to change the background color of the 

browser’s body section. 
There are two way to specific color: 
Using colour code(RGB) 

 RGB colors in HTML are represented as six digit hexadecimal values. 

 color code (hexadecimal value) will be more flexible to handle colors. 

 The six digit hexadecimal value is the combinations of three, two digit number 

sequence represent a color.  

 Color code should be prefixed with #.  

 First two digits represent Red, next two digits for Green and last two digits for Blue 

(RGB) in the range of 00 – FF. For example, 000000 is black and FFFFFF is white. 
FF0000 is bright red. 

Using colour name 

 Colour name can be used for only few colors 

 You can use some basic color names directly  
Define heading Tags in HTML? 

 Headings are used to include titles to sections of a web page. HTML has six levels 
of headings viz. <h1> to <h6>.  
 The number with h indicates the level of heading. Header tags are display the body 

text as bolder and larger in size according to its level.  
The syntax of heading tags:  

 <h…> Heading text </h…> 
Align attribute is used in heading tags: to set right, center and justify alignment in 
Heading. Left is a default alignment  
The tag is to specify the alignment to headings:  

 <h# align = value> 

NOTE: Where # is the level number in heading tag 
Rule in browser application for displaying text? 
 Browser applications are having some special rules for displaying text. They do not 

recognize returns, tabs or even more than one space between words.  
 If you create an HTML document with multiple lines of text, browser will display it 
as a single line. 

Define Line Breaks and Paragraphs Tag? 

 i. The <br> tag is used for line break. The <br> is an empty tag, does not have close 
tag and attribute. It should be placed at the end of a line. 
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 ii. Paragraphs are created using the <p> tag. The content what you type between 

<p> and </p> is identified as a paragraph and display as a paragraph by the browser. 
Because, the browser does not recognize returns (Pressing “Enter” Key). Remember that 
in word processors, pressing “Enter” key is identifying a paragraph. 

 
 

 
 

G.Ganesh.,M.Sc.,B.Ed.,(C.S) 

PGT-COMPUTER TEACHER, 
SRGDS MHSS, Thiruvannamalai. 

+918508689938. 

Tvmganesh1991@gmail.com 
 

 

  

www.Padasalai.Net

www.Padasalai.Net                                                                                    www.TrbTnpsc.com

http://www.trbtnpsc.com/2018/06/latest-plus-one-11th-study-materials-tamil-medium-english-medium-new-syllabus-based.html



 
COMPUTER APPLICATIONS 

11. HTML - Formatting text, Creating Tables, List and Links 

SECTION-B 
Answer to the following questions (2 Marks): 

1. Write a short note on (i) <strong> (ii) <em> 
<strong> Important text 
The <strong> tag is a phrase tag. It is used to define important text. This tag displays 

the text as bold.  
<em> - Emphasized text  

The <em> tag is used to emphasize the text, the text will be in italics. 
2. What is the use of <mark> tag? 
 Highlighting is an important formatting feature is used to call attention to the 

reader.  
 The <mark> tag is used to highlight the text in HTML. This is also a container tag. 
3. Write the following equation as HTML notation: Pd = 25 – Q2 
<Html>   <head>   <title>html notation</title>   </head> 
 <body> Pd = 25 – Q2   </body> 

</html> 
4. Write about any two attributes of font tag. 

 There are three main Attributes for Font tag 

 The face is an attribute to set different font style. The name of a font has multiple 

words it should be specified within double quote.  

 The size attribute is used to set size of the text. The size can have an absolute value 

from 1 to 7. These predefined sizes are known as virtual size. Each virtual size is 
successively 20% larger than the previous one. 

 The color attribute is used to set the color to the text. 
Note: The <font> tag is not supported by HTML5. 

5. What is thematic break?( Book inside 5 Mark ) 
The <hr> (Horizontal Rules) tag, which is known as “Thematic Breaks” separate 
sections of an HTML document visually.  

It produces a horizontal line spread across the width of the browser. This is an empty 
tag 
6. What is pixel? 

 A pixel is one of the tiny dots that make up the display on computer. 72 pixels 
equal to an inch. Pixel is usually referred as points.  

 For example: The code <hr size = 72> display a horizontal line with 1 inch 
thickness. The default size is 3 pixels.  
7. What are the types of list in HTML? 

 HTML supports three types of lists viz. numbered, unnumbered and definition. 
These lists are called as Ordered List, Unordered List and Definition List respectively.  

8. How will you define numbered list? 
Numbered List / Ordered List  

 Numbered list is created within the tag pair <OL> ….. </OL> tag.  

 The tag <LI> is used to present the list item in the list.  

 Ordered list displays items in a numerical or alphabetical order.  

 Both <OL> and <LI> tags are container tags. closing tag </LI> never be used. 
Attributes of Ordered List: 

There are two attributes can be used to customize ordered list, they are  

(1) Type - changing numbering style   

(2) Start - changing numbering order. 
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Type – is used to change the number style. The default number style is standard Arabic 
numerals (1,2,3,…………). 

SECTION-C 
Answer to the following questions (3 Marks): 

1. Write an HTML code to display the following text in exactly the same way as 
given below.  
<html><head><title> Html</title></head> 

<body> 
I am studying Computer Science Application. 

</body</html> 
2. Briefly explain the attributes of <hr> tag. 
Attributes of <hr> tag (ANY 3) 

The <hr> tag having four attributes viz. size, width, noshade and color. These 
attributes are used to set size, width, 3D appearance and color to the horizontal line 
respectively.  

Size:   Thickness of the horizontal line can be changed with size attribute.  
The size is given in terms of pixels. The default size is 3 pixels.  

Width:  The width attribute specifies the horizontal width of the rule line.  
The default rule is drawn across the full width of the browser.  
The value of the width attribute may be the exact width of the rule in pixel or a certain 

percentage.  
the value of the width is specified as percentage. 100% is the default width.  

For example:  
<hr width = 50%> display an half of a horizontal rule line on the browser window. 
Noshade:  The default view of a horizontal rule line is 3D. So, no need to specify the 

term “noshade” as an attribute with <hr> tag. If you specify the attribute “noshade” turn 
off 3D view, turns on 2D view. Noshade is a Boolean type attribute. 
Color:  The horizontal line is displayed in gray color by default. The color attribute 

is used to change is default color to desired color.  
The general syntax of <hr> tag with attributes:  

<hr size=value width=value noshade, color=color_name/code> 
Note: All attributes of <hr> tag is not supported by HTML5 
3. What are the core tags used to create table in HTML? 

There are five core tags are used to create a table in HTML. They are, 
<table> tag is used to create a table. 

<tr> tag defines table rows 
<th> tag defined table columns 
<td> tag is used to specify the data in a cell  

<caption> tag defines title for the table 
4. Write an HTML code to provide hyperlink to https://www.w3schools.com 
<html><head><title> hyperlink </title></head> 

<body> 
<a href= “https://www.w3schools.com/index.html” > w3schools</a> 

</body</html> 
5. Difference between <UL> and <OL> tags. 

<OL> tag <UL> tags 

Ordered list displays items in a 
numerical or alphabetical order. 

Ordered list displays items in a special 
bullet symbol 

Unordered lists are often referred as 
numbered lists 

Unordered lists are often referred as bulleted 
lists 

To list item in <ul> using <li> To list item in <ol> using <li> 

6. Write HTML code to produce the following table: 

<table border=1 cellspacing=0 cellpadding=12> 
<tr VAlign =top> 
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<td rowspan=2>A</td><td> B</td> 
</tr> 

<tr><td> C</td> 
</tr>  

</table> 

SECTION-D 
Answer to the following questions (5 Marks): 

1. Write an HTML code the show the following text: 
Program: 

<html><head><title>table program</title></head> 
<boby> 
<center>MODERN ATOMIC THEORY</center> 

<b>The findings of modern atomic theory are given as follows:</b> 
<ul > 
<li>An atom is the smallest particle which takes part in chemical reaction. 

<li>An atom is considered to be a divisible particle. 
<li>The atoms of the same element may not be similar in all respects. 

<dl> 
<dd>eg: Isotopes (<sub>17</sub>Cl<sup>35</sup>, <sub>17</sub>Cl<sup>37</sup>) 
</dl> </ul> 

<ul> 
<li>The atoms of different elements may be similar in some respects. 

<dl> 
<dd>eg. Isobars (<sub>18</sub>Ar<sup>40</sup>, <sub>20</sub>Ca<sup>40</sup>) 
</dl></ul> 

</body> 
</html> 
2. Explain the attributes used with <table> tag in HTML. 

Attributes of table (Any 3)  
The <table> is a container tag. There are several attributes to improve the layout of the 

table. They are listed below: 
1. Cellspacing: It is used to set the space between cells in a table. The value should be 
in pixels 

2. Cellpadding: It is used to set the space between the contents of a cell and its border. 
the value should be in pixels. 

3. Border: Border attribute with <table> tag is used to specify the thickness of the 
border lines around the table.  
The value of the border attribute should be a non zero value in pixels. (displays the table 

without border). The default value is Zero in most the browsers.  
4. Bordercolor: It is used to apply the colour to the border lines. 
5. Align: It is used to set the position of the table within the browser window. Left is the 

default position. Right or center may be the value of align attribute. 
6. BGcolor: It is used to apply background colour to the table.  

7. Height and Width: 
These two attributes are used to specify the height and width of a table in terms of 
pixels or percentage. 

3. Explain the types of list with suitable HTML code. 
 HTML supports three types of lists viz. numbered, unnumbered and definition. 

These lists are called as Ordered List, Unordered List and Definition List respectively.  
Numbered List / Ordered List  

 Numbered list is created within the tag pair <OL> ….. </OL> tag.  

 The tag <LI> is used to present the list item in the list.  

 Ordered list displays items in a numerical or alphabetical order.  
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 Both <OL> and <LI> tags are container tags. closing tag </LI> never be used. 

Attributes of Ordered List: 
There are two attributes can be used to customize ordered list, they are  
(1) Type - changing numbering style  

 
 
 
 
 
 
 

(2) Start - changing numbering order. 

Type – is used to change the number style. The default number style is standard Arabic 
numerals (1,2,3,…………). 
Start – is used to specify the number of letter with which start the list. The default 

starting point is 1. 
Un-numbered List / Unordered List  

 Unordered lists are often referred as bulleted lists. Instead of numbers,  

 each element in the list has prefixed with a special bullet symbol.  Using<LI> tag 

 Unordered list is surrounded within <UL> ……… </UL> tags 
Attribute of Unordered List:  

type attribute is used to customize bullet style for the list of elements. By default, a solid 
circle is used as bullets. 
 

 
 
 

 
Definition List  

 Definition list is different from other two types of list. No bullet or number is 

provided for the list items. 

 The list element has two parts.  

  (1) A definition term  (2) The definition description 

 Definition list is surrounded within <DL>…….</DL> tags.  

 Definition term is presented in between <DT>…..</DT> tag and  

 Definition description should be surrounded within <DD>....…</DD> tag. 

Example: 

<html> <head> <title> list in Html</title</head> 

<body> 

<ol type=A> 

<li> hardware 

<li> software 

<ul> 

<ul type= square> 

<li> network 
<li> mail 

</ul> 
<dl> 
<dt> HTML 

<dd> Hypertext markup Lanaguage 
</dl> 

Type value Numbering style 

1 Standard Arabic Numerals 1,2,3,4,………………. 

a Lowercase letters a, b, c, d, ………… 

A Uppercase letter A, B, C, D ……….. 

i Lowercase Roman numerals i, ii, iii, iv, v …………… 

I Uppercase Roman numerals I, II, III, IV, V ……….. 

Type value Numbering style 

Disc  A solid circle 

Square   A solid square 

Circle o An unfilled circle www.Padasalai.Net
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</body></html> 
4. What is Link and explain the types of links. 

 Link is an important feature of HTML to connect web resources.  

 Link in HTML is used to create hyperlinks to web content.  

 Web content may be an HTML document(internal) or an external webpage or any 
multimedia content such as an image, video, audio, animation etc., or even a part of 

the current document. 
There are two important things needs to create a link in HTML,  
(1) The name of the file or URL to which you want to link  

(2) The text that will serve as the clickable link.  
The anchor tag <A> is used to create links along with HREF attribute. HREF is 

abbreviated as “Hypertext Reference”.  
Structure of an anchor tag with href: 
<A href = “ Web content path / URL “> Text – Clickable link </A> 

Example:  <A href = "http://tnscert.org/index.html">SCERT </A> 
5. Write HTML code to create the following table: 

</table> 
<table border=1 cellspacing=0 cellpadding=16> 
<tr> 

<td rowspan=3 VAlign=top>A</td> 
<th colspan=4>B</th> 
</tr> 

<tr> 
<td>C</td> 

<td>D</td> 
<td>E</td> 
<td rowspan=2 VAlign=top>G</td> 

</tr> 
<tr> 

<th colspan=3>F</th> 
</table> 

 

Book Question 
Define Tables in HTML  

 Table is grid of rows and columns.  

 The tables were officially introduced with HTML 3.2.  

 Tables are useful for the general display of tabular data.  

 Representing table in HTML is heavy on tags.  

What other Tags used to create table elements  
 Apart from these five core tags, <tbody>, <thead> and <tfoot> tags are also used 

to define and control whole sections of table.  
 All the above tags are container tags. 

What are the Attributes of <TD>, <TH> and <TR> tags: 
1. Align Used to specify the horizontal alignment of content within a cell. Left is the 
default alignment. Possible values are Right and Center. 

2. VAlign  Used to specify the vertical alignment of the contents within a cell. Bottom is 
the default alignment. Possible values are Top and Middle 

3. Width  Used to specify the width of a cell in terms of pixels or percentage. 
4. BGcolor and Background   

 Bgcolor attribute is used to apply a particular colour to the background of a cell.  

 Background attribute is used to apply an image or picture as background of a cell. 

5. Rowspan and Colspan   

 Rowspan attribute is used to merge two or more cells in a row as a single cell.  
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 Colspan attribute is used to merge to two or more cells in a column as a single cell. 

How to format the text in html 

 Format the text such making bold, italic, underline, changing font style, font size, 

font color and more. 

 Formatting text is very important as well as interesting task in creating web pages. 

Formatting is purely based on your imagination and creativity. 
Define Nested Lists:  
 A list block can be defined inside another list is called as nested list. 

What are the Comparison of tags: 

Tag Usage Tag Usage 
Final 

Output 

<b> To show the text in bold <strong> To show important text Bold 

<i> To show the text as italics <em> To Call attention  Italics 

<u> 
To show the text as 

underlined 
<ins> To insert a text Underline 

<s> To show the wrong text <del> 
To replaced or deleted 
text 

Strike 
through  

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 

 
 

G.Ganesh.,M.Sc.,B.Ed.,(C.S) 

PGT-COMPUTER TEACHER, 

SRGDS MHSS, THIRUVANNAMALAI. 
+918508689938. 
Tvmganesh1991@gmail.com 

 

  

www.Padasalai.Net

www.Padasalai.Net                                                                                    www.TrbTnpsc.com

http://www.trbtnpsc.com/2018/06/latest-plus-one-11th-study-materials-tamil-medium-english-medium-new-syllabus-based.html



TAG NAME DESCRIPTION EXAMPLE PROGRAM 

<strong> 
</strong> 

Important text 
The  tag is a phrase tag 
It is used to define important text. 

Welcome to Tamilnadu 
<strong> Welcome to Tamilnadu 
</strong> 

<em> 
</em> 

Emphasized 
text 

Tag is used to emphasize the text. Welcome to Tamilnadu <em> Welcome to Tamilnadu </em> 

<big> 

</big> 
BIG 

Tag is used to define the text bigger 
in size than the normal size.  

It is often used to call attention a 
text 

Computer 
Computer (normal text) 

<big> Computer </big> 

<small> 
</small> 

Small 
Tag is used to define the text smaller 
than the current size. 

Computer (normal text) 
Computer 

<small> Computer</small> 

<Sub> </Sub> Subscript 
A Subscript is a way to display a 
character or a number below the 
normal line of type. 

H2O 
H<sub>2</sub> 
<Sup> Superscript 
 

<Sup> </Sup> Superscript 
A Superscript is also a way to show a 
character or a number above the 
normal line of type. 

(a+b)2 
(a+b)<Sup>2</sup> 
 
 

<del></del> or 
<s> </s> 

Deleting  Or 
Strike through 

Text will be displayed as strike 
through 

Computer 
<s> Computer</s> 
<del> Computer</del> 

<ins> </ins> Inserting Text will be shown as underlined Computer <ins> Computer</ins> 

<Center>  
</center> 

Center 
The tag is used to centralize a 
segment of text. 

Thiruvallur <center> Thiruvallur  < /center> 

 

www.Padasalai.Net

www.Padasalai.Net                                                                                    www.TrbTnpsc.com

http://www.trbtnpsc.com/2018/06/latest-plus-one-11th-study-materials-tamil-medium-english-medium-new-syllabus-based.html



COMPUTER APPLICATIONS 
12. HTML - Adding multimedia elements and Forms 

 
Part – II 

 
Answer to the following questions (2 Marks): 

1. List out the popular image formats. 
Most of the browsers supports, GIF, JPEG and PNG images formats 

 GIF (Graphical Interchange Format)   

 JPEG (Joint Photographic Experts Group)  

 PNG (Portable Network Graphics)  
2. Write down the general format of marquee 

 General format:  
  <marquee> Text or image to be scroll </marquee> 

3. What is inline sound or movie? 

 Music can be played in the background to a webpage, while the page is viewed. This is  
known as ‘inline’ sound or movie.. 

4. What is the purpose of <input> tag? 
 The purpose of <input> tag is to form controls, form controls are created by using 

<input> tag. The <input> is an empty tag used to create different form elements or controls 
such as text box, radio buttons so on. 
5. Which tag is used to specify the list of items in dropdown list box? 

 The <select> tag is used to create dropdown list box in HTML.  

 It provides a list of various options as a dropdown list 
6. What are the major attributes are available in <textarea> tag? Define <textarea> 
 The <Textarea> tag used to receive multi line text data as input. It is a container tag. 

The main attributes of <Textarea> are 
Name – Used to define name to the control 

Rows – Specifies the number of rows in the text area control 
Cols – Specifies the number of columns in the text area. (number of characters in a line) 

 
Part – III 

 
Answer to the following questions (3 Marks): 

1. Write a short note on familiar images format. 
i. GIF (Graphical Interchange Format)  

 This format is one of the popular format for animated images.  

 It was developed by CompuServe.  

 This format is suitable for presenting tiny animated images, logos, icons,etc.,  

 It is not suitable for photographic work, because it uses maximum of 256 colours.  

 Animated GIF do not support sound or playback control. 
ii. JPEG (Joint Photographic Experts Group)  

 JPEG is the most popular image format supported by all web browsers.  

 This format is suitable for photographic images.  

 JPEG can include any number of colours.( supported Full color) 
iii. PNG (Portable Network Graphics)  

 PNG is designed as a replacement for GIF.  

 It is also supported by all browsers. 

iv. SVG (Scalable Vector Graphics) ----  HTML-5 introduces SVG images. 

 SVG is a graphics format that was developed for web.  

 It was standardized by World Wide Web Consortium (W3C) in 2001.  

 All current web browsers supports basic features of SVG. 

2. How will you scroll the text in HTML? 
The HTML <marquee> tag is used for scrolling piece of text or image image can be moved 

horizontally or vertically.This feature makes a web page as more attractive.  
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General format:  
 <marquee> Text or image to be scroll </marquee> 

 
Attributes of <marquee> 

Attribute Value Description 

behavior Scroll, slide, alternate 
 Used to specify the type of scrolling. 

 

direction 
Up, down, left, right 

(Default is left) 

 To specify the direction of the movement of text or 
image. 

 The text or image will move towards right to left by 
default. 

Height & 
Width 

pixels or % 
 These attributes are used to set height and width of 
the marquee. 

loop number 
 Specifies how many times to loop. The default value 
is INFINITE, which means that the marquee loops 
endlessly. 

scrolldelay Seconds(time unit)  Used to Defines time delay between each jump. 

scrollamount number  Used to Defines the speed of the scroll. 

Vspace & 
Hspace 

pixels or %  Specifies vertical space around the marquee. 

3. Explain the main attributes used with <form> tag. 

 Main Attributes used with <form> tag  
The important attributes used with the <form> tag are method and action attributes. 

Method   
The method attribute of the form tag is used to identify how the form element names and 

values will be sent to the server.  
The get method will append the names of the form elements and their values to the URL. 

The post method will send the names and values of the form elements as packets. 
Action  

The action attribute identifies the server side program or script that will process the form. 
The action will be the name of a Common Gateway Interface (CGI) program written in 

programming languages like Perl, JavaScript, PHP or Active Server Pages (ASP). 
 General Format of <form> tag  

   <Form method=get/post action= “back_end_server_script”>  
    Form elements  

   </Form> 
4. Explain the values of <input> tag’s type attribute. 

Value of type 
attribute 

Description 

Text  
Create a Text Box. The element used to get all kind of text input 
such as name, address etc., 

Password 
Similar as Text box. But, while entering data, the characters are 

appearing as coded symbols such as asterisk.  

Checkbox 

Multiselect box 

Check box is an element appearing like a small square box. When the 

user click on the square a tiny tick mark will appear inside the 
square. This element is used to select multiple options. 

Radio Button 

Radio button is used to select any one of the multiple options from 
the list. This element looks like a small circle, when the user select an 

item, a tiny dot will appear within the circle. If the user selects 
another option, previously selected option will be deselected. This 

means, user can select any one of the given option form a group. 

Reset 
It is a special command button used to clear all the entries made in 

the form. 

Submit 
It is also a special command button used to submit all the entries 
made in the form to the backend server. 

Button 
This is a standard graphical button on the form used to call 
functions on click. 
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5. Explain the attributes of <select> and <option> tags. or 
Define select and Option tag? With its attributes 

 The <select> tag is used to create dropdown list box in HTML.  

 It provides a list of various options as a dropdown list.  

 This element is more helpful when a number of options are to be displayed in a limited 
space.  

 The <option> tag is used to specify list items. 
 

Attributes of <Select> tag: Attributes of <Option> tag: 

Name – Provide the name to the control, which is 
sent to the server. 

Size – Determine the style of dropdown list box.  
Size = 1 dropdown list box  

Size = 2 List box 
Multiple – Allows user to select multiple values. 

Selected – Indicate default selection 
 

Value – Value to be submitted to server 
 

Book Question 
How will you Inserting Images with HTML document or Define IMG tag. 

 The <IMG> tag along with the attribute src (Source) is used to add images in HTML 
document. Images displayed on the web page should be converted to universally supported 

format. 
 General format: 

 <img src = image_name_with_extension>   (OR)     <img src = URL> 
Note: If the image is not in the current working folder, the image file name should clearly 

specify with the path of the file or URL, where the file is available. 
 Example:      <img src = “D:\images\animals\cat.jpeg”> 

Attributes of <img> tag:  

Attributes of <img> tag: Description 

Src (Source) 
The main attribute used to specify the file name of the image 
to be inserted 

Alt (Alternative Text) Attribute used to describe the image 

Width and Height 
Attributes are used to set the width and height of an image. 
The values pixels or percentage of its actual size. 

Vspace (Vertical Space) &  
Hspace (Horizontal Space) 

Attributes are used to set Vertical and Horizontal space 
between the images. 

Align 

The align attribute used to aligns the image with respect to 

the base line of the text.  
Bottom – Aligns the bottom of the image with the baseline of 

the text. default setting. 
Middle – Aligns the middle of the image with the baseline of 

the text. 
Top – Aligns the top of the image with the baseline of the text. 

Left and Right values of 
Align attribute 

Its displayed the image on the left and right side of the text. 
 

Note: the browser displays the image in its original size. when attributes are not specified 
Example:  

<img src =“bharathiyar.gif” alt ="National Poet of India" Width=20% Height=25% vpace = 20 
Hspace = 20> 

How will you add Video and Audio into the Webpage 

 Video and Sound are the core part of the modern web pages. 

 A video or audio content may be included as Inline or external data. 

Inline External 

The inline refers to audio or video files are 

handled as part of the page. 

The External refers linking external audio 

or video files as url. 

 The <embed> tag is used to attach an audio or video file easily within webpage.  

 This<embed> tag includes the controls of the multimedia automatically in the browser.  
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 The <noembed> tag may be used as an alternate to display some other media file, in the 

case of the browser does not support <embed> tag. 
Attribute of <embed> tag 

 Src is the primary attribute used with <embed> tag.  

 The src attribute used to specify the name of the media file with its source location.  

 Other attributes such as alt, height, width and align are used as it is used with <img>. 
General Format:  

 <embed src = audio / video file name with location> </embed> 
 

 
How will insert sound or audio file into the html document? 

 Music can be played in the background to a webpage, while the page is viewed. This is 
known as ‘inline’ sound or movie.  

 The <bgsound> tag is used to attach an inline sound file in HTML.  
Attributes of < bgsound > tag:  

 The src attribute is used to define the location of the media file.  
 The Volume attribute used to adjust volume control.  

 The loop attribute defines the duration of play. The ‘infinite’ value causes the audio 
play as long as the page is in view. 

General Format:  <bgsound src= “music file name with location”> 
How will insert form into the html document? 

 The <form> tag is used to create a form.  

 An HTML from starts with <form> and ends with </form> tag. 

 Forms contain many types of form elements, such as text boxes, radio buttons, check 
boxes, buttons and drop-down lists. 

 The form has a special element, which is submit button, which will submit the entries of 
a form to a server application to process the entries. 

 The values they enter or select are passed with the name of the corresponding form 
element to the Web server. 

Attributes frequently used with <form> tag  
The important attributes used with the <form> tag are method and action attributes. 

Method  
The method attribute of the form tag is used to identify how the form element names  

The get method will append the names of the form elements and their values to the URL. 
The post method will send the names and values of the form elements as packets. 

Action  
The action attribute identifies the server side program or script that will process the form. 

The action will be the name of a Common Gateway Interface (CGI)  
General Format of <form> tag  

 <Form method=get/post action= “back_end_server_script”>  
  Form elements  

 </Form> 
 

Form Controls:  
 In HTML, there are different types of form controls are used to collect data. They are 

Text box, Password, Checkbox, Radio buttons, Text area, Select box, Submit and Reset 
Button. 

<Input> Tag  
 Most of the form controls are created by using <input> tag. The <input> is an empty 
tag used to create different form elements or controls such as text box, radio buttons so on. 

 
Attributes of <input> tag: 

Type: This attribute is used define the type of control to be created by <input> tag. The 
values of type attribute are Text box, Password, Checkbox, Radio buttons, Text area, Select 

box, Submit and Reset Button. 
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Name: This attribute of <input> tag is used to assign a name to the input controls. The data 
values are passed to the server along with the names of the controls. 

Value: This attribute is used to define default value to some controls. 
Size: This is used to set the width of the input text in terms of characters. It is applicable 

only for textbox and password boxes. 
Maxlength: This attribute of <input> tag is used to set the length of the input character 

(number of characters to be inputted) to the textbox and password boxes. 
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